
Step One:
If you shoot in JPEG or TIFF mode (or 
JPEG + Raw), you’ll want to set your cam-
era’s color space to match what you’re 
going to use in Photoshop for your color 
space (to get consistent color from your 
camera to Photoshop to your printer, 
you’ll want everybody speaking the 
same language, right?). I recommend 
you change your camera’s color space 
from its default sRGB to Adobe RGB 
(1998), which is a better color space for 
photographers whose final image will 
come from a color inkjet printer.

Step Two:
You’ll usually find the Color Space con-
trol under your camera’s shooting menu 
(as seen here). Change the space to 
Adobe RGB. If you’re not sure where to 
find it on your camera, just dig up your 
owner’s manual (or, ideally, download it 
in PDF format from the manufacturer’s 
website) to find out how to make the 
switch to Adobe RGB (1998). Again, if 
you’re shooting in RAW, you can skip 
this altogether.

Although there are entire books written on the subject of color management, in this chapter we’re  

going to focus on just one thing—getting what comes out of your color inkjet printer to match  

what you see onscreen. That’s what it’s all about, and if you follow the steps in this chapter, you’ll  

get prints that match your screen. We’re going to start by setting up your camera’s color space, so  

you’ll get the best results from screen to print. Note: You can skip this if you only shoot in RAW.

Setting Up Your Camera’s Color Space
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Resolution for Printing
This is one of those topics that tend to make people crazy, and since there is no Official Board of Resolution  

Standards, this is the type of thing that gets argued endlessly in online discussion forums. That being said, I take  

the word of my friend and fellow photographer Dan Steinhardt from Epson (the man behind the popular Epson  

Print Academy), who lives this stuff day in and day out (Dan and I did an online training class on printing and this  

was just about the first topic we covered, because for so many, this is a real stumbling block). Here’s what we do:

Step One:
To see what your current photo’s resolu-
tion is, go under the Image menu and 
choose Image Size (or press Command-
Option-I [PC: Ctrl-Alt-I]). Ideally, for 
printing to a color inkjet printer, I like 
to be at 240 ppi (pixels per inch), but I 
often print at 200 ppi, and will go as low 
as 180 ppi (but 180 ppi is absolutely the 
lowest I’ll go. Anything below that and, 
depending on the image, you’ll start 
to visibly lose print quality). So, I guess 
the good news here is: you don’t need 
as much resolution as you might think 
(even for a printing press). Here’s an 
image taken with a 30-megapixel camera 
and you can see that at 240 ppi, I can 
print an image that is around 22x15".

Step Two:
Here’s the resolution from a 6-mega-
pixel camera. At 240 ppi I can only print 
an 8x12.5" image. So, to make it larger, 
I’d turn off the Resample Image check-
box, type in 200 as my new resolution, 
and then I’d have an image size of 10x15" 
(with no loss of quality). If I lower it to 
180 ppi (as low as I would ever go), then 
I get the print up to a finished size of 
11x16.75" (nearly that of a 12-megapixel 
camera), and I did it all without losing 
quality (because I turned off the Resa-
mple Image checkbox, but before you 
do this, you need to read about resizing 
in Chapter 8 in the book).
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Step One:
Before we do this, I just want to reiterate 
that you only want to make this change 
if your final print will be output to your 
own color inkjet. If you’re sending your 
images out to an outside lab for prints, 
you should probably stay in sRGB—both 
in the camera and in Photoshop—as 
most labs are set up to handle sRGB 
files. Your best bet: ask your lab which 
color space they prefer. Okay, now on to 
Photoshop: go under the Edit menu and 
choose Color Settings (as shown here).

Step Two:
This brings up the Color Settings dialog. 
By default, it uses a group of settings 
called “North America General Purpose 
2.” Now, does anything about the phrase 

“General Purpose” sound like it would 
be a good space for pro photographers? 
Didn’t think so. The tip-off is that under 
Working Spaces, the RGB space is set to 
sRGB IEC61966–2.1 (which is the long-
hand technical name for what we simply 
call sRGB). In short, you don’t want to 
use this group of settings. They’re for 
goobers—not for you (unless of course, 
you are a goober, which I doubt because 
you bought this book, and they don’t 
sell this book to goobers. It’s in each 
bookstore’s contract).

Photoshop’s default color space is sRGB (some pros refer to it as “stupid RGB”), which is fine for photos going  

on the web, but your printer can print a wider range of colors than sRGB (particularly in the blues and greens).  

So, if you work in sRGB, you’re essentially leaving out those rich, vivid colors you could be seeing. That’s why we 

either change our color space to Adobe RGB (1998) if you’re shooting in JPEG or TIFF, which is better for printing 

those images, or ProPhoto RGB if you shoot in RAW or work with Lightroom. Here’s how to set up both:

Setting Up Photoshop’s Color Space
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Step Three:
To get a preset group of settings that’s 
better for photographers, from the 
Settings pop-up menu, choose North 
America Prepress 2. Don’t let it throw 
you that we’re using prepress settings 
here—they work great for color inkjet 
printing because it uses the Adobe RGB 
(1998) color space. It also sets up the 
appropriate warning dialogs to help you 
keep your color management plan in ac-
tion when opening photos from outside 
sources or other cameras (more on this 
on the next page).

Step Four:
If you’re shooting in RAW exclusively, 
or using Lightroom (Adobe’s awesome 
application for photographers), then 
you’ll want to change your color space in 
Photoshop to ProPhoto RGB to get the 
best prints from your RAW images (plus, 
if you use Lightroom, you’ll wind up 
moving images back and forth between 
Lightroom and Photoshop from time to 
time, and since Lightroom’s native color 
space is ProPhoto RGB, you’ll want to 
keep everything consistent. While you 
might use Lightroom for your JPEG or 
TIFF images, there’s really no advantage 
to choosing ProPhoto RGB for them). 
You change Photoshop’s Color Space to 
PhotoPro RGB in the Color Settings di-
alog (just choose it from the RGB menu, 
as shown here). That way, when you 
open a RAW photo in Photoshop (or im-
port a file from Lightroom), everything 
stays in the same consistent color space 
and if you wind up bringing an image 
from Lightroom over to Photoshop, and 
end up printing it in Photoshop (instead 
of jumping back to Lightroom for print-
ing), you’ll get better results.
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Step Five:
About those warnings that help you 
keep your color management on track: 
Let’s say you open a JPEG photo, and 
your camera was set to shoot in Adobe 
RGB (1998), and your Photoshop is set the 
same way. The two color spaces match, 
so no warnings appear. But, if you open 
a JPEG photo you took six months ago, 
it will probably still be in sRGB, which 
doesn’t match your Photoshop working 
space. That’s a mismatch, so you’d get 
the warning dialog shown here, telling 
you this. Luckily it gives you the choice of 
how to handle it. I recommend converting 
that document’s colors to your current 
working space (as shown here).

Step Six:
You can have Photoshop do this con-
version automatically anytime it finds 
a mismatch. Just reopen the Color Set-
tings dialog, and under Color Manage-
ment Policies, in the RGB pop-up menu, 
change your default setting to Convert 
to Working RGB (as seen here). For 
Profile Mismatches, turn off the Ask 
When Opening checkbox. Now when 
you open sRGB photos, they will auto-
matically update to match your current 
working space. Nice!

Step Seven:
Okay, so what if a friend emails you a 
photo, you open it in Photoshop, and 
the photo doesn’t have any color profile 
at all? Well, once that photo is open in 
Photoshop, you can convert that “un-
tagged” image to Adobe RGB (1998) by 
going under the Edit menu and choos-
ing Assign Profile. When the Assign 
Profile dialog appears, click on the Pro-
file radio button, ensure Adobe RGB 
(1998) is selected in the pop-up menu, 
then click OK.
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When we apply sharpening, we apply it so it looks good on our computer screen, right? But when 

you actually make a print, a lot of that sharpening that looks fine on a 72- or 96- dpi computer 

screen gets lost on a high-resolution print at 240 ppi. Because the sharpening gets reduced 

when we make a print, we have to sharpen so our photo looks a bit too sharp onscreen, but 

then looks perfect when it prints. Here’s how I apply sharpening for images I’m going to print:

Step One:
Start by doing a trick my buddy Shelly 
Katz shared with me: duplicate the Back
ground layer (by pressing Command-J 
[PC: Ctrl-J]) and do your print sharpen-
ing on this duplicate layer (that way, you 
don’t mess with the already sharpened 
original image on the Background layer). 
Name this new layer “Sharpened for 
Print,” then go under the Filter menu, 
under Sharpen, and choose Unsharp 
Mask. For most 240 ppi images, I apply 
these settings: Amount 120; Radius 1; 
Threshold 3. Click OK.

Step Two:
Next, reapply the Unsharp Mask filter 
with the same settings by pressing Com-
mand-Option-F (PC: Ctrl-Alt-F). Then, 
at the top of the Layers panel, change 
the layer blend mode to Luminosity (so 
the sharpening is only applied to the 
detail of the photo, and not the color), 
then use the Opacity slider to control 
how much sharpening is applied. Start 
at 50% and see if it looks a little bit 
oversharpened. If it looks like a little bit 
too much, stop—you want it to look a 
little oversharpened. If you think it’s way 
too much, lower the opacity to around 
35% and re-evaluate. When it looks right 
(a little too sharp), make a test print. My 
guess is that you’ll want to raise the 
opacity up a little higher, because it 
won’t be as sharp as you thought.

Sharpening for Printing
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Step One:
First, contact the photo lab where you’re 
sending your image, and ask what color 
profile they want you to use. Chances 
are they are going to want you to con-
vert your image to sRGB color mode. I 
know this flies in the face of what we 
do when we print our own images, but 
I know a number of big, high-quality 
photo labs that all request that you con-
vert your images to sRGB first, and for 
their workflow, it works. If they don’t 
request you convert to sRGB, they 
may have you download a color profile 
they’ve created for you, and you’ll use 
it the same way as you’ll assign sRGB in 
the next step.

Step Two:
With your image open in Photoshop, go 
under the Edit menu, choose Convert 
to Profile, and you’ll see the image’s 
current color profile at the top of the 
dialog (here, my image is a RAW image, 
so it’s set to ProPhoto RGB). Under Des-
tination Space, from the Profile pop-up 
menu, choose sRGB IEC61966-2.1. If 
you downloaded a profile from your 
lab, you’ll choose that instead (more 
on where to save downloads on page 
11). Click OK, and don’t be surprised if 
the image looks pretty much the same. 
In fact, be happy if it does, but at least 
now it’s set up to get the best results 
from your photo lab.

Sending Your Images to Be Printed at a Photo Lab
Besides printing images on my own color inkjet printer, I also send a decent amount 

of my print work out to a photo lab (I use Bay Photo, Miller’s Professional Imaging, and 

Mpix.com) for a number of reasons—like if I want metallic prints, or I want the image 

mounted, matted, and/or framed with glass, or I want a print that’s larger than I can print 

in-house. Here’s how to prep your images for uploading to be printed at a photo lab:
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Step One:
I use Datacolor’s Spyder hardware color 
calibrator (it’s around $169 street price), 
because it’s simple, affordable, and a lot 
of the pros I know have moved over to 
it. So, I’m going to use it as an example 
here, but it’s not necessary to get this 
same one, because they all work fairly 
similarly. You start by installing the soft-
ware that comes with the Spyder. Then, 
plug the sensor into your computer’s 
USB port and launch the software, which 
brings up the main window (seen here). 
You follow the “wizard,” which asks you 
a couple of simple questions (stuff like, 

“Is this the first time you’ve calibrated 
your monitor using Spyder?” Or, maybe, 

“What’s the capital of Nebraska?”), and 
then it does the rest.

Step Two:
Start by clicking the Next button in 
the bottom right, and the window you 
see here will appear. If you’re new to 
calibrating your monitor, I recommend 
using the Step-by-Step Assistant (which 
is already selected by default), so at this 
point just click the Next button again.

If you really want what comes out of your printer to match what you see onscreen, then I don’t want to have 

to be the one to tell you this, but…you absolutely, positively have to calibrate your monitor using a hardware 

calibrator. The good news is that today it’s an absolutely simple, totally automated process. The bad news is 

that you have to buy a hardware calibrator. With hardware calibration, it’s measuring your actual monitor and 

building an accurate profile for the exact monitor you’re using, and yes—it makes that big a difference.

You Have to Calibrate Your Monitor  
Before You Go Any Further
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Step Three:
The next screen asks you which type 
of calibration you want to do. Are you 
going to just update an older calibra-
tion you did previously with the Spyder 
(then you would choose the ReCAL radio 
button), or do you just want to check to 
see how accurate your current calibra-
tion is (CheckCAL), or are you doing 
this for the first time (which you are, so 
you’d click the FullCAL radio button, as 
shown here)? Then, just click the Next 
button, because you’re going to leave all 
the pop-up menus here at their default 
recommended settings.

Step Four:
The next screen asks you to put the 
Spyder unit on your monitor, which 
means you drape the sensor over your 
monitor so it sits flat against it and the 
cord hangs over the back. It shows you 
exactly where to place it (the two blue 
arrows you see beside its outline actu-
ally flash on/off, so you can’t possibly 
miss where it goes). The sensor comes 
with a counterweight you can attach to 
the cord, so you can position the sen-
sor approximately in the center of your 
screen without it slipping down. Once 
the sensor is in position over your screen, 
click the Next button, sit back, and relax. 
You’ll see the software conduct a series 
of onscreen tests, using gray, white, and 
various color swatches, as shown here.
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Step Five:
This testing only goes on for a few min-
utes (at least, that’s all it took for my 
laptop), and then it’s done. It asks you to 
name your profile (it puts a default name 
in place for you), so enter a name, and 
then click the Save button. Below that is 
a pop-up menu where you can choose 
when you want an automatic reminder 
to “Recalibrate your monitor” to pop up 
on your screen. The default choice is 2 
Weeks (so please don’t tell anyone that I 
actually set mine to 1 Month). Make your 
choice and then click the Next button. 

Step Six:
Now you get to see the usually shocking 
before/after. Click on the Switch but-
ton at the bottom right and you can 
switch back and forth between your 
now fully calibrated monitor and your 
uncalibrated monitor. It’s at that mo-
ment you say, ”Ohhhhhh…that’s why 
my prints never match my screen.” Well, 
it’s certainly one part of the puzzle, but 
without this one critical piece in place, 
you don’t have a chance with the rest, so 
you did the right thing. Click Next one 
last time, and then click the Quit button 
in the Profile Overview screen.
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Step One:
Your first step is to go to the website 
of the company that makes the paper 
you’re going to be printing on and 
search for their downloadable color 
profiles for your printer. I use the term 

“search” because they’re usually not in 
a really obvious place. I use a Canon 
imagePROGRAF PRO-1000 printer and 
I generally print on Canon paper. When 
I installed the PRO-1000’s printer driver, 
I was tickled to find that it also installed 
custom color profiles for all Canon pa-
pers, but some printers don’t. So, if I 
needed to download them, the first stop 
would be Canon’s website, where I’d go 
under Support and click on the Soft-
ware & Drivers link (as shown here). 
Note: Even if you’re not a Canon user, 
still follow along (you’ll see why).

Step Two:
Once you get to the Software & Drivers 
page, enter your printer model name/
number in the search field, and then 
choose it from the pop-up menu (as 
shown here).

When you buy a color inkjet printer and install the printer driver that comes with it, it basically lets Photoshop 

know what kind of printer is being used, and that’s about it. But to get pro-quality results, you need a color 

profile for your printer based on the exact type of paper you’ll be printing on. Most inkjet paper manufacturers 

now create custom profiles for their papers, and you can usually download them free from their websites. 

Does this really make that big a difference? Ask any pro. Here’s how to find and install these profiles:

The Other Secret to Getting Pro-Quality  
Prints That Match Your Screen

The Adobe Photoshop Book for Digital Photographers

Step-by-Step Printing and Color Management 011Bonus Chapter 03



Step Three:
On the printer’s product page, beneath 
Downloads, you’ll see that it recognizes 
if you’re using a Mac or Windows, but 
you may need to choose your operat-
ing system. After that’s set, scroll down 
and click the Load More button, scroll 
down a little more, and you’ll then see 
imagePROGRAF PRO-1000 series ICC 
Profile for Supporting the Other Com-
panies’ Media. Click on the Download 
button to its right (as shown here). After 
it downloads onto your computer, on a 
Mac, the profile file should be placed 
in your Library/ColorSync/Profiles folder. 
To get to that folder (it’s hidden), press-
and-hold the Option key, then go under 
the Go menu, and choose Library. There, 
you’ll find the ColorSync folder, and 
within that, you’ll find the Profiles folder. 
Just drag-and-drop it in there. In Win-
dows, just Right-click on the unzipped 
file and choose Install Profile. You don’t 
even have to restart Photoshop—you 
download them, install them, and they’ll 
be waiting for you in Photoshop’s print 
dialog (I’ll show how to choose them 
in the Print dialog a little later). Easy 
enough. But what if you’re not using 
Canon paper? Or if you have a different 
printer, like an Epson or an HP?

Step Four:
We’ll tackle the different paper issue 
first (because they’re tied together). 
Say I wanted to print from my PRO-
1000 using a different brand of paper 
other than Canon. For example, say I 
wanted to use Hahnemühle Photo Rag® 
Ultra Smooth paper instead. So, even 
though I’m printing on a Canon printer, 
now I’d go to Hahnemühle’s website 
to find their color profiles for my PRO-
1000. (Remember, profiles come from 
the company that makes the paper.) On 
the Hahnemühle home page, click on 
the Download Center link, under ICC 
Profile, under Digital FineArt on the left 
side of the page (as shown here).

The Adobe Photoshop Book for Digital Photographers

Step-by-Step Printing and Color Management012 Bonus Chapter 03



Step Five:
On the ICC Profiles page, choose your 
printer make and model, then the type 
of paper you want to print on from the 
pop-up menus. It will display a list of 
free paper profiles (as seen here), so just 
click on the one you want to download 
(as shown here, where I’m clicking on the 
Photo Rag® Ultra Smooth profile). 

Step Six:
Now, just like we did in Step Three, on a 
Mac, the unzipped profile file should be 
placed in your Library/ColorSync/Pro-
files folder. Press-and-hold the Option 
key, then go under the Go menu, and 
choose Library. Within the ColorSync 
folder, you’ll find the Profiles folder (seen 
here, at the bottom). Just drag-and-
drop it in there. In Windows, just Right-
click on the unzipped file and choose 
Install Profile.
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Step Seven:
Now, you’ll access your profile by choos-
ing Print from Photoshop’s File menu. In 
its dialog, change the Color Handling 
pop-up menu to Photoshop Manages 
Color. Then, click on the Printer Pro
file pop-up menu, and your new color 
profile(s) will appear. In our example 
here, I’m printing to a Canon PRO-1000 
using Hahnemühle Photo Rag® Ultra 
Smooth paper, so that’s what I’m choos-
ing as my printer profile. More on using 
these color profiles later in this chapter.

TIP: Creating Your Own Profiles
You can also pay an outside service 
to create a custom profile for your 
printer. You print a test sheet (which 
they provide), overnight it to them, and 
they’ll use an expensive colorimeter 
to measure your test print and create 
a custom profile. The catch: it’s only 
good for that printer, on that paper, 
with that ink. If anything changes, your 
custom profile is just about worthless. 
Of course, you could do your own  
personal printer profiling (using some-
thing like one of X-Rite’s i1 Software), so 
you can re-profile each time you change 
paper or inks. It’s really determined 
by your fussiness/time/money factor 
(if you know what I mean).
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Step One:
Go under Photoshop’s File menu and 
choose Print (as shown here) or just 
press Command-P (PC: Ctrl-P).

Step Two:
When the Photoshop Print Settings dia-
log appears, let’s choose your printer 
first. At the top right, choose the printer 
you want to print to from the Printer 
pop-up menu (here, I’m going to be 
printing to my Canon PRO-1000). You 
can choose your page orientation by 
clicking on the portrait and landscape 
Layout icons at the bottom of the 
Printer Setup section (as shown here). 
By the way, you’ll be happy to know 
that you can actually resize this dialog 
to any size you’d like by clicking on the 
bottom-right corner and dragging it out. 

Okay, so at this point, you’ve set Photoshop to the proper color space for the type of photo you’re going to be  

printing (RAW, JPEG, TIFF, etc., see page 3), you’ve hardware calibrated your monitor (see page 8), and you’ve  

even downloaded a printer profile for the exact printer model and style of paper you’re printing on. In short— 

you’re there. Luckily, you only have to do all that stuff once—now you can just sit back and print. Well, pretty much.  

The Photoshop Print Settings dialog has some options you’ll want to know about, which we’ll cover here:

Making the Print (Finally, It All Comes Together)
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Step Three:
If you want your image to fit fully on the 
page, scroll down to the Position and 
Size section and turn on the Scale to Fit 
Media checkbox (as shown here) and 
it scales the image down in size, so the 
entire image fits on the page without 
being cropped (the image is less wide 
here than what we saw back in Step Two). 
Just so you know: I have no problem 
turning this Scale to Fit Media checkbox 
on if my image is going to shrink in size 
to fit the paper, but if turning that on 
would wind up increasing the size, I’ll hit 
the Cancel button and go to the Image 
Size dialog (under the Image menu) and 
resize it there, so I have control over the 
upsizing process (see Chapter 8 in the 
book for more on resizing).

Step Four:
While we’re talking about size, there’s 
another Print feature, which gives you 
the ability to just print part of your 
image (so, it’s kind of like cropping 
the print without actually cropping the 
image itself). You do this in the Position 
and Size section by turning on the Print 
Selected Area checkbox. When you 
turn this on, you’ll see little arrows ap-
pear around the corners of your image. 
Just click-and-drag these in toward your 
image, and as you do, it darkens the 
areas to be cropped away (as seen here, 
where I’ve dragged those arrows on the 
top left, top right, and top left side). 
Now, only the area that’s not darkened 
will actually wind up being printed on 
the page.
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Step Five:
Another resizing feature here is the abil-
ity to just click-and-drag on your photo 
to reposition and/or resize it. To use this 
feature, first make sure the Scale to Fit 
Media checkbox is turned off, and then 
click-and-drag the image around so you 
can reach a corner handle surrounding 
your image. Then, just click-and-drag a 
corner handle inward, and it resizes your 
image (kind of like Free Transform does). 
Here, I scaled the image down in size 
and positioned it where I wanted by just 
clicking-and-dragging it in the preview 
area. Now, before we go on to the next 
step, you’re probably wondering what 
that lined area around the outside edge 
of your paper is all about. That’s showing 
you where the margins are (the non-
printable areas of your paper).

Step Six:
If you want to be able to print all the way 
to the border (and have those margin 
lines and non-printable areas go away), 
all you have to do is to set your margins 
to 0 inches. You do this by clicking on 
the Print Settings button in the top 
right of the dialog (as shown here, at 
the top) to bring up your OS Print (PC: 
Printer Properties) dialog (as seen here, 
at the bottom). (Note: I use Canon print-
ers, but if you have an Epson or HP, the 
dialog will have the same basic function, 
just in a different layout.) When you 
choose a paper size that is borderless 
(as shown here), you can now print to 
the edges of the paper (well, as long 
as your printer supports edge-to-edge 
printing, of course). Now, take a look 
at the preview—the margin area lines 
are gone.
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Step Seven:
Okay, now let’s turn on our Color Man
agement, so our prints will match what 
we see onscreen. In the Color Manage
ment section, you’ll see that, by default, 
the Color Handling is set up to have your 
printer manage colors (instead of Photo
shop). You really only want to choose 
this if you weren’t able to download any 
printer/paper profiles for your printer. 
Having your printer manage colors like 
this is your backup plan, not your first 
choice. But, today’s printers have got-
ten to the point that if you have to go 
with this, it still does a decent job (that 
wasn’t always the case). Instead, I rec-
ommend that you choose Photoshop 
Manages Colors (as shown here). That 
way, it uses the color profile we down-
loaded earlier for our printer and paper 
combination, which will give us the best 
possible match.

Step Eight:
Next, you’ll need to choose that printer/
paper profile you downloaded and in-
stalled earlier. So, from the Printer Pro-
file pop-up menu, choose the printer/
paper profile that matches your printer 
and paper (here, I’ll choose the pro-
file for the Hahnemühle Photo Rag® 
Ultra Smooth paper I installed earlier). 
Now, Photoshop and the printer know 
exactly which paper you’ll be printing 
on, and it’s optimized to give you the 
best possible color print on that printer 
using that paper (this is very important, 
because this sends a whole series of 
instructions to the printer, including 
everything from the amount of ink it 
should lay down, to the drying time of 
the paper, to the proper platen gap for 
the printer, and so on).
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Step Nine:
Next, you’ll need to choose the Render
ing Intent. There are four choices here, 
but only two I recommend: either Rela-
tive Colorimetric (which is the default 
setting) or Perceptual. Here’s the thing: 
I’ve had printers where I got the best 
looking prints with my Rendering Intent 
set to Perceptual, but currently, on my 
Canon PRO-1000, I get better results 
when it’s set to Relative Colorimetric. So, 
which one gives the best results for your 
printer? I recommend printing a photo 
using Perceptual, then printing the same 
photo using Relative Colorimetric, and 
when you compare the two, you’ll know.

TIP: �The Gamut Warning  
Isn’t for Us

The Gamut Warning checkbox (beneath 
the preview area) is not designed for 
use when printing to a color inkjet (like 
we are here) or any other RGB printer. It 
warns you if colors are outside the print-
able range for a CMYK printing press, so 
unless you are outputting to a printing 
press, you can leave it turned off.

Step 10:
Lastly, just make sure the Black Point 
Compensation checkbox is turned on 
(it should be by default) to help maintain 
more detail and color in the shadow 
areas. Now, click the Print Settings but-
ton in the top-right corner (we’re not 
quite done yet).

WARNING: If you’re printing to a color 
inkjet printer, don’t ever convert your 
photo to CMYK format (even though 
you may be tempted to because your 
printer uses cyan, magenta, yellow, and 
black inks). The conversion from RGB to 
CMYK inks happens within the printer 
itself, and if you do it first in Photoshop, 
your printer will attempt to convert it 
again in the printer, and your printed 
colors will be way off.
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WARNING: From this point on, what ap-
pears in the OS Print dialog is contingent 
on your particular printer and operating 
system (again, I use Canons). You may or 
may not be able to access these same 
settings, so you may need to view each 
option to find the settings you need to 
adjust. If you’re using a Windows PC, you 
may have to click on the Advanced tab or 
an Advanced button to be able to choose 
from similar settings.

Step 11:
In your OS Print dialog, your printer will 
already be chosen in the Printer pop-up 
menu. Under Printer Options, click on 
Color Matching (as shown above). On 
a PC, click on the Properties button, 
and then Photo Printing in the Com-
monly Used Settings section at the top 
of the Quick Setup tab, where you’ll see 
the Color Intensity Manual Adjustment 
checkbox. Turn this on and it will bring 
up the Manual Color Adjustment dia-
log. On a Mac, when the Color Matching 
options appear, you’ll see your printer’s 
color management may be turned off 
and grayed out (as seen here, below). 
If it is, ColorSync should be selected 
rather than Color Matching, since you’re 
having Photoshop manage your color. 
You don’t want the printer also trying to 
manage your color, because when the 
two color management systems both 
start trying to manage it, nobody wins. 
So, if you’re on a Mac, and if it’s not 
already set to ColorSync, be sure to 
switch it. On a PC (this may be slightly 
different, depending on your brand of 
printer), you should already be in the 
Manual Color Adjustment dialog. Click 
on the Matching tab up top, then click 
None under Color Correction (that way, 
only Photoshop is managing the color, 
and click OK.
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Step 12:
Now, choose Quality & Media in the 
OS Print dialog (on a Windows PC, these 
paper choices are at the bottom of the 
Quick Setup tab in the Properties panel, 
so when you closed the Manual Color 
Adjustment dialog, you should be back 
in the right place already.) For Media 
Type, choose the type of paper you’ll be 
printing to from the pop-up menu (as 
seen here, where I chose Highest Den-
sity Fine Art Paper). In that same Quality 
& Media section, select High from the 
Print Quality pop-up menu. Again, this 
is for printing to a Canon printer. If you 
don’t have a Canon printer, choose the 
one that most closely matches the paper 
you are printing to. On a Windows PC, 
for Print Quality, choose High from the 
pop-up menu. Now, click OK, then Save 
on a Mac. On a PC, click OK twice to 
close the dialogs. Back in the Photoshop 
Print Settings dialog, hit the Print button 
to get prints that match your screen, as 
you’ve now color managed your photo 
from beginning to end.
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Your Print Is Too Dark:
This is one of the most common prob-
lems, and it’s mostly because today’s 
monitors are so much more incredibly 
brighter (either that, or you’re literally 
viewing your images in a room that’s too 
dark). Luckily, this is an easy fix and here’s 
what I do: Press Command-J (PC: Ctrl-J) 
to duplicate the Background layer, then 
at the top of the Layers panel, change 
the layer blend mode to Screen to make 
everything much brighter. Now, lower 
the Opacity of this layer to 25% and (this 
is key here) make a test print. Next, look 
at the print, and see if it’s a perfect match, 
or if it’s still too dark. If it’s still too dark, 
set the Opacity to 35% and make another 
test print. It’ll probably take a few test 
prints to nail it, but once you do, your 
problem is solved (by the way, this is a 
great thing to make into an action).

Your Print Is Too Light: 
This is less likely, but just as easy to fix. 
Duplicate the Background layer, then 
change the layer blend mode to Multiply 
to make everything darker. Now, lower 
the Opacity of this layer to 20% and 
make a test print. Again, you may have 
to make a few test prints to get the right 
amount, but once you’ve got it, you’ve 
got it. Now, make that into an action 
(name it something like “Prep for Print”) 
and any time you print, just run that 
action first. (We looked at actions in 
Chapter 9 in the book.)

Okay, what do you do if you followed all these steps—you’ve hardware calibrated your monitor, 

you’ve got the right paper profiles, and color profiles, and profiles of profiles, and so on, and you’ve 

carefully turned on every checkbox, chosen all the right color profiles, and you’ve done everything 

right—but the print still doesn’t match what you see onscreen? You know what we do? We fix it in 

Photoshop. That’s right—we make some simple tweaks that get the image looking right fast.

What to Do If the Print Still  
Doesn’t Match Your Screen
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Your Print Is Too Red (Blue, etc.):
This is one you might run into if your 
print has some sort of color cast. First, be-
fore you mess with the image, press the 
letter F on your keyboard to put a solid 
gray background behind your photo, 
and then just look to see if the image 
onscreen actually has too much red. If it 
does, then press Command-U (PC: Ctrl-
U) to bring up Hue/Saturation. From the 
second pop-up menu, choose Reds, then 
lower the Saturation amount to –20%, 
and then (you knew this was coming, 
right?) make a test print. You’ll then know 
if 20% was too much, too little, or just 
right. Once you make a few test prints 
and nail it, save those steps as an action 
and run it before you print each time.

Your Print Has Visible Banding:
The more you’ve tweaked an image, the 
more likely you’ll run into this (where the 
colors have visible bands, rather than just 
smoothly graduating from color to color. 
It’s most often seen in blue skies). There 
are two ways to deal with this: If you shot 
in RAW, make sure you keep the image 
in 16-bit mode (don’t have it down sam-
ple to 8-bit when it leaves Camera Raw). 
Click the Workflow Options link beneath 
the Preview area in Camera Raw, and 
choose 16 Bits/Channel from the Depth 
pop-up menu. Stay in 16-bit through the 
entire printing process. If your original 
was a JPEG, then there’s no going back 
to a 16-bit original (and just converting 
to 16-bit mode does nothing), so instead 
try this: Go under the Filter menu, under 
Noise, and choose Add Noise. In the 
dialog, set the Amount to 4%, click on 
the Gaussian radio button, and turn on 
the Monochromatic checkbox. You’ll 
see the noise onscreen, but it disap-
pears when you print the image (and 
usually, the banding disappears right 
along with it).
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Step One:
To launch Contact Sheet II (the II part 
comes from the fact that this is the sec-
ond version of this automated script, a 
big improvement over the first one. But, 
honestly when I heard Adobe was bring-
ing this back, I was hoping for Contact 
Sheet III. Sigh), go under the File menu, 
under Automate, and choose Contact 
Sheet II (as shown here).

Step Two:
This brings up the Contact Sheet II dia-
log, where you get to choose how your 
contact sheet will look. You start at the 
top by clicking on the Choose button 
and selecting which folder of images 
you want to create a contact sheet of. 
In the next section down, Document, 
you get to choose the size and res
olution of your contact sheet. In our 
example, we’re going to make a wide 
10x8" sheet at a resolution of 240 ppi 
(pretty standard resolution for a color 
inkjet printer). I always leave the Flatten 
All Layers checkbox turned on, so when 
it’s done I’m not looking in my Layers 
panel and seeing 36 different layers, 
and that’s pretty much what you’ll get if 
you choose not to flatten all layers.

For reasons known only to a secret society of Adobe engineers (who meet in underground catacombs 

buried deep below Adobe’s headquarters and lit solely by torches), they chose to remove the Contact 

Sheet feature back in an earlier version of Photoshop. I guess they assumed we’d use the PDF Contact Sheet 

in Bridge, which can only mean they never actually tried it themselves. Thankfully, after the public stormed 

Adobe’s headquarters with axes and pitchforks, they brought Contact Sheet II back a number of years 

ago, and the balance of power has been restored to the kingdom. Here’s how to unleash its wrath:

Making Contact Sheets in Photoshop
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Step Three:
The next section down, Thumbnails, is 
where you choose how many columns 
and rows you want. In our example, 
we’re going to do four across, with five 
rows deep. I generally leave the Use 
Auto-Spacing checkbox turned on, be-
cause it has Photoshop do the math to 
figure out how to make the thumbnails in 
your contact sheet as large as possible. 
However, if you turn that checkbox off, 
you can type in what you’d like for your 
vertical and horizontal spacing (the only 
time I would do this is if I wanted more 
space along the top and sides. As you’ll 
see in the next step, this one has them 
spread out, so they’re really close to the 
side edges of the paper and pretty darn 
close to the top and bottom).

Step Four:
The last section, Use Filename as Cap-
tion, at the bottom of the dialog, is 
pretty important (even though I turned 
it off here), and that is the option for the 
filename of each photo to appear below 
the thumbnail. If you’re using this as a 
proof sheet for a client, that’s pretty 
important. My only recommendation for 
this would be to use a smaller font size 
than the default 12-point, which always 
seems too large to me (especially if you 
have a long filename). Try 9- or 10-point, 
and I also would try a sans serif font, 
like Myriad Pro (rather than the default 
Minion Pro), simply because it looks 
better. Now, click the OK button up 
top, and in about 20 or 30 seconds, the 
contact sheet you see here appears. 
This particular one uses 20 photos (4 
columns by 5 rows), but if your folder 
contains more than 20 photos, it just 
keeps making more contact sheets until 
every photo is accounted for.
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I don’t usually include how to do soft proofing in my books because I don’t use—or recommend—soft 

proofing myself, and I don’t want to include techniques I don’t really use. But, I have had so many people ask 

me about it, I felt I had to include it. Just know that my advice about this is simple: nothing beats a real proof. 

If you’re serious about making great prints, make a test print—soft proofing just gives you a hint of what it 

might look like. A test print is what it actually looks like. Okay, I’m off my soap box. Here’s how it’s done:

Soft Proofing in Photoshop

Step One:
Start by downloading the free color pro-
file from the company that makes the 
paper you’re going to be printing on 
(see page 11 for where to get these and 
how to install them). Open the image 
you want to soft proof, then under the 
View menu, under Proof Setup, choose 
Custom (as shown here).

Step Two:
When the Customize Proof Condition 
dialog appears, from the Device to Sim
ulate pop-up menu, choose the color 
profile for the printer/paper combo 
you’ll be using (here, I’ve chosen the 
profile for the Hahnemühle Photo 
Rag® Ultra Smooth paper printing 
on the Canon PRO-1000 I installed 
earlier). Next, choose the Rendering 
Intent (see page 19 for more on this), 
and make sure you leave Black Point 
Compensation turned on. Down in the 
Display Options (On-Screen) section, 
leave Simulate Paper Color and Simu-
late Black Ink both turned off. You can 
toggle the Preview checkbox on/off to 
see a before/after of the simulation of 
what your print might look like with that 
profile on that paper (though, of course, 
it can’t simulate how your sharpening 
might look on different papers, just 
the color. Kinda). Give it a try and then 
compare it with a real test print, and 
you’ll be able to determine if soft proof-
ing is for you.

The Adobe Photoshop Book for Digital Photographers

Step-by-Step Printing and Color Management026 Bonus Chapter 03


